
MAC SWITCH 101 

Although it may feel like you're entering a brand new world with your Mac, you'll be happy to know 
that Finder has some familiar similarities to Windows Explorer. For example, you still have a 
desktop and windows, you still access many functions from menus, you can still use keyboard 
shortcuts to accomplish tasks quickly, and more. 

In Windows you used Windows Explorer to manage your files. In Mac OS X, you use the Finder to 
manage your files. You can search for files, copy files, move files, or delete files. You can also see 
file server connections, inserted DVDs, and USB thumb drives. 

Elements of the Mac OS X desktop and Finder, and their Windows Explorer equivalents 

Here is a sample Mac desktop and Finder window (in Cover Flow view mode), labeled so we can 
compare it to Windows. Some of the following Mac OS X features may not be available in Windows. 
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1. Apple (�) menu - Similar to the Start menu in Windows; used to access functions such as 
Software Update (equivalent to Windows Update), System Preferences (equivalent to Control 
Panel), Sleep, Log Out, and Shut Down. 

2. Menu bar - This is always at the top of your screen. It contains the Apple menu, active 
application menu, menu bar extras and the Spotlight icon. The Finder menu has items such as 
Finder Preferences, Services, and Secure Empty Trash. 

3. Finder window close, minimize and zoom buttons–just like in Windows but on the left. Note: 
Closing all application windows in Mac OS X does not always quit the application as it does in 
Windows. In Mac OS X every application menu has a Quit option that can also be invoked by 
using the Command-Q key combination. 

4. Finder window View buttons Equivalent to the options contained in the View menu of Windows 
Explorer.  

5. Icon view - Similar to Windows Icons view mode, used to display the contents of your folder as 
a series of icons. Also you can "hover" over icons for multipage documents or QuickTime 
movies to get a thumb nail preview of its content. 

6. List view - Similar to Windows Details view mode, used to display your folder in a spreadsheet-
style manner. Each folder can be expanded by clicking on the disclosure triangle just to the left 
of the folder. You can easily sort by file name, date modified, and so forth. Choose Show View 
Options from the View menu to add / remove attribute columns. You can change the sorting 
from ascending order to descending order and back again by clicking on the attribute column 
title. 

7. Column view - Used to display the hierarchy of your hard disk where each column represents a 
folder. 

8. Cover Flow view - Used to display the contents of your folder just like the Cover Flow used in 
iTunes. You can see live previews of images, documents, and movies, and can thumb through 
documents and movies. 

9. Action Menu - Similar to right clicking an item in Windows Explorer, it will give you quick access 
to Finder functions for highlighted items, such as Get Info, Quick Look, Move to Trash, and 
Services. 

10. Item Arrangement - Similar to Group By, Stack By in Windows Explorer, it will group the items 
in a folder by a certain criteria, such as Name, Kind, Application, Date Last Opened, Date 
Added, and more. 

11. Search Field - Similar to Windows Search, start typing a word or phrase and Spotlight will 
search your Mac for any matches. 

12. Spotlight icon - Similar to Windows Search, click it to bring up the Spotlight search field, where 
you can search for anything on your Mac. 

13. Back / Forward buttons - Just like in Windows Explorer, as you move to different places in the 
Finder window, you can use the back button to return one step back and the forward button to 
go forward. 

14. Sidebar - Similar to the Task Pane in Windows Explorer, items are grouped into categories: 
Favorites, Shared, and Devices. The Favorites section contains quick access to your desktop, 
Applications, downloads, and Documents. The Shared and Devices sections display whatever 
is connected to your Mac, such as a hard disk, iDisk, network share points, an SD memory 
card, or DVDs. 

15. Cover Flow content - Shows you a live preview of your files, where you can page through a 
document or watch a QuickTime movie. 

16. The Finder application icon -  Similar to Windows Explorer, click it to bring the Finder to the 
foreground or open a Finder window if none are already opened. 
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17. The Dock - Similar to the Windows Taskbar, it has quick access to the Finder and your most 
frequently used applications, folders, and files. With a single click the application, folder, or file 
opens. 

18. Trash - Similar to the Recycle Bin, deleted items are kept here until you empty the Trash. You 
can also eject DVD's, SD memory cards, or external drives connected to your Mac by dragging 
them to the trash (discs will physically eject when you do this, other devices can be 
disconnected after doing this). 

 
 
 

Switch 101: On Windows, I used to... 

Summary 

You may be used doing certain tasks on your Windows computer in particular ways. This lesson 
shows you how to accomplish the same tasks on a Mac. 

Products Affected 

Mac OS X 10.5, Mac OS X 10.6, OS X Lion, Windows 7, Windows  

In Windows, I used to... On a Mac, I can... 

Right-click my mouse to access 
commands or perform actions in a 
shortcut menu. 

If you're using an Apple one-button mouse, Control-click 
items (press and hold the Control key while you click) to 
access commands or perform actions in a shortcut menu. 
Or you can opt to use a multibutton mouse, and right-click 
as usual. 

To enable the secondary button on a mouse: From the 
Apple (�) menu or the Dock, choose System Preferences. 
Select Mouse and choose the Secondary Button from one 
of the Primary Button pop-up menus. 

If you're using a MacBook or MacBook Pro computer's 
trackpad: From the Apple (�) menu or the Dock, choose 
System Preferences. Select Trackpad and select the 
checkbox "Place two fingers on trackpad and click button 
for secondary click." Now you can hold two fingers on the 
trackpad and click to use the shortcut menu. If you 
selected the Clicking option, then right-click is enabled 
simply by tapping two fingers simultaneously onto the 
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trackpad. 

Press the Backspace key to delete or 
the Delete key to forward delete 

Press Delete key to backwards delete. For Mac portables, 
press the Function (fn) and Delete key to forward delete. 

Use My Computer to see and access 
everything on my computer. 

Open a Finder window, choose Computer from the Go 
menu. From here you can view and access all the files on 
your Mac. 

You can also use Spotlight to quickly and accurately locate 
anything on your computer. 

 

Use the Start menu and the taskbar to 
access programs, folders, and files. 

Use the Dock and Launchpad (in OS X Lion) to access 
applications or your favorite items. 

To add aliases to your favorite items, drag and drop them 
to the right side of the Dock. To add your favorite 
applications, drag and drop them to the left side of the 
Dock. You can drag the icons off the Dock at any time to 
delete the aliases. 

Use Windows Explorer to find 
programs, files, and folders on my 
computer. 

Use the Finder to find applications, files, or folders on your 
computer. 

 

To open a new Finder window, click the Finder icon on the 
Dock. 

Use My Computer to access content 
from various drives, such as a hard 
drive or a optical disc. 

See and access content on any mounted disk, mounted 
volume (external hard drives and flash drives), or discs 
(CD or DVD) by double-clicking the appropriate icon that 
appears in the devices list in Finder when the device or 
media is connected or inserted. If certain kinds of discs 
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don't appear on the desktop as expected, choose 
Finder > Preferences, click the Sidebar button, and check 
which items should appear (under DEVICES). 

Use these keys as shortcuts:  

 Shift key 
 Control key 
 Alt key 
 Windows key 
 Backspace key 

Use these keys as alternatives:  

 Shift key 
 Control key 
 Option key 
 Command key 
 Delete key 

In Windows, I also used to... On a Mac, I can... 

Press Ctrl+Alt+Delete to terminate 
unresponsive programs. 

Press Command-Option-Escape (Esc) to force quit 
unresponsive applications. Once you press these keys, 
select any application from the Force Quit window and 
click Force Quit. 

You can also Force Quit by Control-clicking the item on the 
Dock and select Force Quit. 

Click the close box to close windows. 

Click the close button (the round, red one in the upper-left 
corner) to close windows. 

 

Click the close box to exit programs. 
From the application menu, choose Quit Application name, 
or press Command-Q, to quit an application. 
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Click the minimize box to minimize 
windows to the taskbar. 

Click the minimize button (the round, yellow one in the 
upper-left corner) to minimize windows to the Dock. You 
can also use Command-M as a shortcut. 

 

Click the maximize box to maximize 
my window. 

Click the zoom button (the round, green one in the upper-
left corner) to expand your window. 

 

When you're in an application window, you can make the 
window full screen by clicking the full screen button in the 
top-right corner of the application window. 
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In Windows, I also used to... On a Mac, I can... 

Press a button to eject discs or disks. 

Drag the disc, disk, or volume icon to the Trash (it turns 
into an Eject icon) to eject or unmount items. 

Or, in the Finder window click the Eject icon next to the 
volume to unmount it. 

 

You can also press the Eject key on your keyboard (in the 
upper-right corner) to eject a CD or DVD. 

Press the Control (Ctrl) key for 
keyboard shortcuts (such as Ctrl+C to 
copy). 

Press the Command key for keyboard shortcuts (such as 
Command-C to copy). 

Press the Alt key as a modifier, or to 
type special characters. 

Press the Option key as a modifier, or to type special 
characters (such as é). You can learn more about inputting 
special characters here. 

Perform various functions from 
window menus. 

Perform various functions from menus in the menu bar at 
the top of your screen. The contents of the menu bar 
changes, according to the current active application. 
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In Windows, I also used to... On a Mac, I can... 

Access Properties to set application, 
folder, or file options. 

Use the Info window to set application, folder, or file 
options. To open an Info window, select an item and 
choose Get Info from the File menu (or press Command-I).

Move unwanted files and folders to the 
Recycle Bin. 

Drag unwanted files and folders to the Trash in the Dock. 
To empty the Trash, choose Empty Trash from the Finder 
menu (or press Shift-Command-Delete in the Finder). 

You can also click on the file that you would like to delete 
and use Command-Delete as a shortcut. 

Rename documents by clicking 
Rename this file in the File Tasks 
menu. 

Select any file, folder, or application and press the Enter 
key to display the name in a text box. Rename the item as 
anything you like by typing over the text. 

 

Use the Performance control panel to 
check system performance. 

Use Activity Monitor to check system performance. To 
open Activity Monitor in OS X Lion, click the Launchpad 
icon in the Dock, and click Utilities. Then click Activity 
Monitor. 

Make shortcuts to an item by dragging 
and pressing Alt or make a copy by 
dragging and pressing Ctrl. 

To make an alias to an item, click it once and from the File 
menu choose Make Alias (or press Command-L). Or, drag 
the item and press the Command key and the Option key, 
a black arrow will appear, drop the item to make an alias. 

To make a copy of an item, select it and from the File 
menu choose Duplicate (or press Command-D). Or, drag 
the item and press the Option key, a green Add circle will 
appear, drop the item to make a copy. 

In Windows, I also used to... On a Mac, I can... 

Store and access files in My Store files and content in your Documents and Pictures 
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Documents and My Pictures folders. folders. 

To access your Documents and Pictures folders, open 
Finder and select Documents or Pictures from the favorites 
list of the Finder sidebar. In Finder under the favorites list, 
you also have folders to store your music and movies. 

Use Windows Messenger to chat with 
buddies. 

Use iChat to chat with buddies. iChat allows you to chat 
with anyone who has an AIM (AOL Instant Messenger), 
Yahoo, Google Talk, or me.com address. If you don't have 
one, you can sign up for an Apple ID for free and you can 
get a me.com account, go here to learn more). 

Use Microsoft Photo Editor (or My 
Pictures) to view and edit pictures, 
Windows MovieMaker to edit my home 
movies, and Windows Media Player to 
listen to tunes. 

Use iPhoto to view and edit pictures, iMovie to edit your 
home movies, and iTunes or QuickTime Player to listen to 
tunes. 

iTunes also allows you to burn music discs, buy music and 
movies from the iTunes Store, and more. 

Your Mac may also come with GarageBand to compose 
your own music and iDVD to make your own DVDs (if your 
Mac has a DVD burner). 

Use ScreenTaker to take pictures of 
my screen. 

Use Grab or Preview to take pictures of your screen. To 
take a screen shot, press Command-Shift-3. 

In Windows, I also used to... On a Mac, I can... 

Use the Control Panel to customize 
various settings. 

Use System Preferences to customize various settings. 

 

To open it, click the Launchpad icon in the Dock (in 
OS X Lion), then click System Preferences. Or click 
System Preferences from the Dock. Then click an item that 
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you'd like to configure. 

Use Network Connections to configure 
network settings. 

Use Network preferences to configure (and troubleshoot) 
network settings. 

To open Network preferences, click the Launchpad icon in 
the Dock, and click System Preferences. Then click 
Network. 

Use Printers & Faxes to set up my 
printer and fax tasks. 

Use Print & Scan preferences to set up your printer and 
fax tasks. 

To open Print & Scan preferences, click the Launchpad 
icon in the Dock, and click System Preferences. Then click 
Print & Scan. 

Use Device Manager to get 
information about my computer. 

Use System Information to get hardware and software 
information about your computer. From the Apple (�) 
menu, choose About This Mac, then click More Info. 

 

Important: Information about products not manufactured by Apple is provided for information 
purposes only and does not constitute Apple’s recommendation or endorsement. Please contact 
the vendor for additional information. 

 

 
Source: http://support.apple.com/kb/HT2512   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


